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Sažetak: Sažetak treba sažeto i jasno predstaviti sadržaj rada, ne prelazeći 
duljinu od 200 riječi. Sažetak mora precizno definirati cilj rada, ukratko 
opisati korištene metode istraživanja ili analize, istaknuti najvažnije rezul-
tate te sažeto iznijeti glavne zaključke i implikacije rada. Važno je napo-
menuti da se u sažetku ne koriste reference (citati literature), jednadžbe ili 
kratice. Sažetak treba biti napisan tako da je razumljiv i bez čitanja cijelog 
rada. 
Ispod sažetka, autori trebaju navesti od tri do pet ključnih riječi koje su re-
levantne za temu rada i koje će pomoći u njegovom indeksiranju. Ključne 
riječi trebaju biti pažljivo odabrane kako bi odražavale glavne teme i kon-
cepte rada.

Ključne riječi: ključna, riječ, ključna riječ, ključ, rečenica

1. OPĆI IZGLED

1.1. Opće informacije o časopisu

„Fizika izvan okvira” je časopis posvećen promicanju fizike kao temeljne zna-
nosti te njenom mjestu u suvremenom društvu. Naša ciljana publika su učitelji i 
nastavnici fizike (i srodnih područja), nastavnici u svim područjima interdisci-
plinarnih znanosti, sveučilišni stručnjaci, edukatori, stručnjaci iz područja edu-
kacije fizike (i ostalih područja) te svi zainteresirani pojedinci koji prepoznaju 
važnost fizike u razumijevanju svijeta oko nas.

Časopis objavljuje stručne radove iz područja fizike te srodnih disciplina ko-
je interdisciplinarno povezuju fiziku s drugim područjima znanosti, tehnologije, 
umjetnosti i slično. Posebno potičemo autore da prijave:

*autor za kontakt: mirko@acme.com
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• Stručne  radove koji  opisuju  primjenu fizike  u  nastavi  i  obrazovanju, 
uključujući inovativne metode poučavanja, primjere dobre prakse  i ana-
lize problema u nastavi fizike, iz konteksta poučavanja i učenja.

• Pregledne radove koji sintetiziraju najnovija saznanja iz područja fizike 
i srodnih disciplina, s posebnim naglaskom na primjenu u nastavi i obra-
zovanju.

• Prikaze knjiga, udžbenika i drugih nastavnih materijala koji su relevant-
ni za nastavu fizike.

• Osvrte na znanstvene i stručne skupove, radionice i druge događaje koji 
doprinose profesionalnom razvoju učitelja i nastavnika fizike.

• Radove koji opisuju interdisciplinarne projekte i aktivnosti koje povezu-
ju fiziku s drugim područjima znanosti i umjetnosti u obrazovnom kon-
tekstu.

• Originalne znanstvene radove koji prezentiraju rezultate istraživanja u 
području fizike i/ili srodnih područja, pod uvjetom da se u radu jasno 
naglašava povezanost s fizikom i njenim principima te je poželjno, ali 
ne i isključivo, da je rad relevantan za nastavu i obrazovanje.

U svim objavljenim radovima naglašavamo važnost originalnosti, relevant-
nosti, visoke znanstvene kvalitete te jasnog i pristupačnog izražavanja. Nadamo 
se da će "Fizika izvan okvira" biti inspirativno mjesto za razmjenu ideja, znanja 
i iskustava te da će doprinijeti popularizaciji fizike i jačanju veza između razli-
čitih područja znanosti, tehnologije i društva.

1.2. Opće informacije o radovima

U „Fizici izvan okvira” preporučujemo da radovi slijede sljedeću strukturu. 

Uvod treba jasno definirati problem ili temu, dati pregled relevantne literatu-
re te objasniti svrhu i ciljeve rada. Zatim, Metode trebaju detaljno opisati kori-
štene metode, tehnike ili pristupe, osiguravajući dovoljno informacija za razu-
mijevanje i ponavljanje postupka. Slijedi Rezultati, koji jasno i objektivno pre-
zentiraju rezultate ili nalaze, koristeći tablice, grafikone i slike za vizualizaciju. 
U Raspravi interpretirajte rezultate, usporedite ih s postojećim znanjem te ras-
pravite o implikacijama i ograničenjima. Zaključak treba sažeto iznijeti glavne 
zaključke i naglasiti doprinos rada. Prije popisa literature, preporučujemo odje-
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ljak  Zahvale  (Acknowledgments) za zahvale osobama, institucijama ili finan-
cijskim izvorima koji su pridonijeli radu. 

Ova struktura može odstupati ukoliko se radi o preglednim radovima i slič-
no. Maksimalan broj riječi u radovima je 5000, uključujući i literaturu.

1.3. Slanje radova i postupak recenzije

Molimo Vas da svoj rad naziva:

Prezime(dopisnog ili glavnog autora)_I(inicijal imena)_FIO_(go-
dina).odt

pošaljete u formatu .odt (kako je u nazivu rada već naznačeno) na e-mail adresu 
udruga.ufos@gmail.com s naznakom „ZA FIO [godina]”. Svi radovi prolaze 
proces sadržajne recenzije (peer review), u kojem neovisni stručnjaci procjenju-
ju kvalitetu i relevantnost rada, kao i tehničku recenziju usklađenosti članka s 
propozicijama časopisa, koju provode glavni i tehnički urednik . Proces recenzi-
ranja obično traje mjesec dana. Za sva pitanja vezana uz časopis i proces objav-
ljivanja, molimo Vas da pošaljete e-mail na  udruga.ufos@gmail.com s nazna-
kom „ZA UREDNIŠTVO FIO”.

1.4. Izjave o etici

„Fizika izvan okvira” pridaje veliku važnost etici publikacija. Stoga autori jam-
če da je njihov rad originalan, da ne sadrži plagijarizam (uključujući samoplagi-
jarizam) te da su svi izvori pravilno citirani. Autori također moraju otkriti sve 
potencijalne sukobe interesa koji bi mogli utjecati na objektivnost i vjerodostoj-
nost rada.

Ukoliko su autori koristili alate umjetne inteligencije (AI) u procesu pisanja 
rada (npr. za generiranje teksta, analizu podataka ili izradu slika), to je potrebno 
jasno navesti u odjeljku „Metode” ili u zasebnoj napomeni (npr. fusnoti) na po-
četku rada, uz detaljan opis korištenih alata i njihove uloge. Autori su odgovor-
ni za provjeru i osiguranje da je korištenje AI transparentno i etički opravdano 
te da se poštuju autorska prava i pravila citiranja.

Časopis se pridržava smjernica za etiku znanstvenih publikacija koje prepo-
ručuje COPE (Committee on Publication Ethics). Za dodatne informacije o etič-
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kim pitanjima u znanstvenom izdavaštvu, molimo Vas da posjetite web stranicu 
COPE-a: https://publicationethics.org/.

Obrazloženje: 

• „Metode” ili fusnota: Ove opcije nude transparentnost. Fusnota privlači 
pažnju na početku, dok „Metode” kontekstualiziraju AI u istraživačkom 
procesu.

• Detaljan opis: Ovo osigurava transparentnost oko toga kako je AI kori-
šten.

• Naglasak na odgovornosti: Autori zadržavaju odgovornost za provjeru 
AI rezultata.

1.5. Izgled dokumenta

Predložak je rađen za LibreOffice Writer. LibreOffice (nadalje LO[1]) je besplat-
ni paket otvorenog koda namijenjen uredskoj obradi podataka. Razvijen je od 
strane neprofitne organizacije The Document Foundation (utemeljena 2010.g) 
kao nasljednik paketa OpenOffice.

LibreOffice  je  svojevrsna  besplatna  alternativa  najčešće  korištenom ured-
skom paketu Microsoft Office i potpuno je uskladiv s njegovim alatima (podr-
žava sve Microsoft Office ekstenzije), a dostupan je i na svim učestalijim desk-
top platformama: Linux, Windows i Mac OS. 

Lokaliziran je na više od 110 različitih jezika, uključujući i hrvatski. Osim 
standardne (desktop) verzije paketa, LibreOffice je moguće instalirati i na poje-
dine mobilne uređaje. Trenutno je dostupna LibreOffice besplatna aplikacija za 
Android – LibreOffice Viewer. Aplikacija omogućava pregled svih dokumenata 
izrađenih pomoću LibreOfficea, a sadrži i osnovne funkcije za uređivanje sadr-
žaja (izmjena i oblikovanje teksta, promjena fonta i sl.).

LibreOffice prilikom izrade dokumenata koristi .ODF format. ODF (Open 
document Format) otvoreni je format za spremanje i razmjenu različitih ured-
skih dokumenata (tekstualni dokumenti, proračunske tablice, grafičke prikaze i 
prezentacije), koji se temelji na XML baziranom sustavu datoteka i postao je 
međunarodni ISO standard. Korištenjem ovakvog formata, omogućena je raz-
mjena i editiranje dokumenata neovisno o vrsti programa i uređaju i predstavlja 
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otvorenu alternativu vlasničkim formatima dokumenta Microsoft Office alata 
(.doc, .xls, .ppt)[2].

Korisne poveznice kako se koristi LibreOffice Writer i Math su:

• LibreOffice – The free and private office suite  [3]

• This is LibreOffice  [4]

• LibreOffice Bookshelf  [5]

• Learn Libreoffice Writer in 20 Minutes  [6]

• Writing Equations in LibreOffice  [7]

Pri pisanju rada striktno se pridržavati načina pisanja prema primjerima iz 
ovog predloška.

U pisanju obavezno koristiti LibreOffice i
stilove iz ovog predloška!

Iako Microsoft Word može čitati ODF formate, prilikom snimanja zapisuje 
svoje dijelove koda koji kasnije stvaraju probleme.

1.6. Kvaliteta

Poželjno je da dokument u pismenom obliku bude dobrog i logičnog izgleda te 
u konačnoj formi (dovršen). Npr. ovo je način* kako unijeti fusnotu.

Poglavlje odmah nakon (pod)naslova mora ostati  neuvučeno (Body Text), 
dok sva sljedeća poglavlja su uvučena (First Line Indent).

Naglašeni tekst uvijek se piše kurzivom (“italic”): Najlakše je to izvesti priti-
skom kombinacije tipki “CTRL+I”, te tada  napisati odgovarajući tekst i vratiti 
se u standardni način pisanja s “CTRL+M”.

1.7. Naslovi poglavlja

Glavne naslove pisati VELIKIM slovima i to podebljanim slovima, a podnas-
lovi velikim i malim podebljanim italiziranim slovima.

*Fusnote zapisujemo na ovaj način.
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1.8. Poglavlja i odlomci

Nakon naslova poglavlja slijedi odlomak koji nije uvučen i obavezno se primje-
njuje „Body Text” stil.

Nakon toga je svaki sljedeći odlomak uvučen i potrebno je koristiti „First Li-
ne Indent” stil.

Ako se objašnjava pojedini izraz:

E=mc2, (1.1)

nakon čega se navode i objašnjavaju fizičke veličine, koristi se neuvučeni 
„Body Text” stil.

Molimo Vas striktno se pridržavati navedenog oblikovanja odlomaka.

2. TABLICE

Tablice smjestiti blizu mjesta u tekstu na koje se odnose. Opis tablice neka se 
nalazi iznad iste. Primjer uporabe slijedi:

Tablica 2.1: Tekst opisa tablice dolazi ovdje. Potrebno je opisati sadržaj 
tablice. Citati se pozivaju na sljedeći način [8].

Bla, Bla Bla, Bla Bla, Bla
Bla, Bla Bla, Bla Bla, Bla
Bla, Bla Bla, Bla Bla, Bla

3. IZRAZI I JEDNADŽBE

Jednostavne varijable ili fizičke veličine pišu se nakošeno (“CTRL+I”), npr.: t, 
x, x2, fi, itd. Za pisanje kompliciranijih izraza koristi se Math uređivač (editor).

Međutim, preporučljivo je i jednostavne varijable zapisati pomoću Math-a. 
Math editor se poziva odgovarajućom ikonom na alatnoj traci ili jednostavnije 
kraticom: „ALT+SHIFT+E”. Npr. prijašnji jednostavni izrazi zapisani pomoću 
LO Math editora su oblika:  t ,  x,  x2,  f i, itd. Tekst se može označiti i pozvati 
Math editor (ALT+SHIFT+E), te se automatski pretvara u matematički izraz.
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Jednadžbe je potrebno centrirati na stranici i numerirati. Nakon jednadžbe 
uvijek kratko opisati korištene fizičke veličine. Ovo je osobito važno na mjesti-
ma gdje se oznake prvi puta navode ili ako su korištene u nekom udaljenom di-
jelu teksta. Primjerice: otpor shunta RS

* računa se prema izrazu†

RS=
I A RA

I−I A

, (3.1)

gdje je: I A nazivna struja ampermetra; I  nazivna struja shunta; R A otpor amper-
metra.

Prilikom pisanja veličina i jedinica obvezno je pridržavati se Zakona o mjeri-
teljstvu i drugih zakonskih propisa Republike Hrvatske. Obvezna je uporaba je-
dinica SI (Međunarodni sustav mjernih jedinica). Prema tom Zakonu varijable i 
oznake veličina pišu se kurzivnim (italic) slovima (npr. duljina l, brzima v, vri-
jeme t), a jedinice uspravnim slovima (npr. metar m, amper A, volt V). Nadalje, 
decimalne se vrijednosti označavaju zarezom, a ne točkom‡

RS=15 461202,376Ω. (3.2)

Uvijek se ostavlja razmak između brojčanog iznosa i oznake jedinice osim 
kada se piše iznos kuta u stupnjevima, minutama i sekundama. Iznos neke veli-
čine G izražava se kao umnožak brojčanog iznosa {G} i njene jedinice [G ]. Pre-
ma tome iznos se izražava kao:  G={G} [G ].  Primjer:  brojčani  iznos jakosti 
struje nećemo pisati kao I (A) ili I [A ] nego {I }/[ I ].

Upute za pisanje i oblikovanja matematičkih izraza mogu se pronaći na slje-
dećim dokumentima::

• The Printing of Mathematics: Some Hints for N on-mathematicians[10]

• IUPAC. Quantities, Units, and Symbols in Physical Chemistry[11]

*prečac u LO Writer-u za unos formula unutar teksta: SHIFT+ALT+E
†prečac u LO Writer-u za unos formula kao zaseban odjeljak: upisati„fn”, pa pritisnuti tipku F3 
(tzv. FN+F3)[9]

‡Znate li da je decimalni znak u hrvatskom pravopisu decimalni zarez (HRN ISO 31-0:1996, 
Veličine i jedinice - 0. dio: Opća načela (ISO 31-0:1992)), a ne decimalna točka? S druge stra-
ne, Hrvatsko matematičko društvo kao vrhovna strukovna udruga ipak preporučuje uporabu de-
cimalne točke.
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Ako se izrazi nalaze unutar teksta odlomka u Math-u mora se postaviti opcija 
„Format → Text Mode”. Izraz je tada prilagođen retku teksta i npr. izgleda ova-
ko: ∂2 s

∂ t2 =v2 ∂2 s
∂ x2 . Inače ista jednadžba bez „Text Mode” opcije bi neprimjereno bi-

la velika i ne bi odgovarala visini retka: 
∂2 s

∂ t2 =v2 ∂2 s

∂ x2 . Takva veličina je prilago-

đena i zapisuje se samo u jednom retku (Display Style), kao što je:

∂2 s

∂ t2 =
E
ρ

∂2 s

∂ x2 (3.3)

Na jednadžbe se referiramo kao jed. (3.4) gdje je (3.4) broj jednadžbe. Oba-
vezno pomoću „Insert → Cross-Reference” opcije (vidi sliku 3.2).

U numeraciji jednadžbi broj treba biti dan na posljednjem retku. Jednadžba s 
numeracijom se upisuje AutoText funkcijom: upisom fn ili FN, pa pritiskom tip-
ke: F3. Npr.:

E=mc2 (3.4)

Jednadžbe se obilježavaju brojem u običnoj zagradi, prvi broj je redni broj po-
glavlja, a drugi broj je broj formule u tom poglavlju.

Dvostrukim klikom na numeraciju, može se odabrati način brojanja jednadž-
bi, vidi sliku 11. Mijenjanje načina numeracije jednadžbi vrši se odabirom „Up 
to level”.
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Slika 3.1: Pozivanje na broj jednadžbe.

Slika 3.2: Mijenjanje načina numeracije jednadžbi: 
odabirom „Up to level”.
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4. SLIKE I FOTOGRAFIJE

Korištenje grafičkih prikaza je svakako dobrodošlo. Od programa za izradu gra-
fičkih  prikaza  preporučamo:  LibreOffice  Draw,  LibreOffice  Calc,  LabPlot2, 
GIMP, Inkscape.

Slika 4.1. Tekst opisa slike treba 
opisati priloženu sliku. Neka ne 

sadrži više od 150 riječi.

5. REFERENCE

Kako upisivati bibliografiju u LO Writer programu u kojem je pisan ovaj pred-
ložak opisano je u: „The LibreOffice Help: Creating a Bibliography”[8].

5.1.1. Citiranje

Citira se uporabom integrirane baze: Insert → Table of Contents and Index → 
Bibliography Entry → New (vidi sliku 5.1).

10



FIZIKA  izvan okvira                                                                F□#

Slika 5.1: Bibliografska baza ugrađena u 
dokument.

U odgovarajuća polja se unose podaci o bibliografskom zapisu ovisno o vrsti 
publikacije (slika 5.2).

Za vrstu publikacije (TYPE):

1. Article:

◦ Short name: kratka oznaka, npr. PrezimeGodina
◦ Author(s): Prezime1, I1.; Prezime2, I2.
◦ Title: Naslov rada (bez navodnika)
◦ Journal: Naziv ili skraćenica časopisa (bez navodnika)
◦ Volume: Volumen časopisa
◦ Year: Godina izdavanja
◦ Page(s): Broj stranice/a rada u časopisu

Konačan izgled[12]:

Author(s), „Title”, Journal (Volume), Year, Page(s)

Prezime1, I1.; Prezime2, I2.: „Naslov rada”, Naziv ili skraćenica časopisa 
(Volumen časopisa), Godina izdavanja, Broj stranice/a rada u časopisu

2. Book:

◦ Short name: kratka oznaka, npr. PrezimeGodina
◦ Author(s): Prezime1, I1.; Prezime2, I2.
◦ Book title: Naslov knjige (bez navodnika)
◦ Publisher: Izdavač
◦ Year: Godina izdavanja

11
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Konačan izgled[13]:

Author(s), „Book title”, Publisher, Year

Prezime1, I1.; Prezime2, I2.: „Naslov knjige”, Izdavač, Godina izdavanja

3. Conference proceedings:

◦ Short name: Kratka oznaka, npr. PrezimeGodina
◦ Author(s): Prezime1, I1.; Prezime2, I2.
◦ Title: Naslov rada (bez navodnika)
◦ Book title: Naslov konferencijskog zbornika
◦ Editor (Urednik/urednici zbornika): EdPrezime1, EdI1.; EdPrezime2, 

EdI2.
◦ Publisher: Izdavač ili naziv organizacije, konferencije, skupa
◦ Address: Mjesto održavanja konferencije
◦ Month: Mjesec održavanja konferencije
◦ Year: Godina održavanja konferencije
◦ Page(s): Broj stranice/a rada u zborniku

Konačan izgled[14]:

Author(s), „Title”, Book title (eds. Editor), Publisher, Address, Month, 
Year, Page(s)

Prezime1, I1.; Prezime2, I2.: „Naslov rada”, Naslov konferencijskog 
zbornika (eds. EdPrezime1, EdI1.; EdPrezime2, EdI2.), Izdavač ili naziv 
organizacije, konferencije, skupa, Mjesto održavanja konferencije, 
Mjesec održavanja konferencije, Godina održavanja konferencije, Broj 
stranice/a rada u zborniku

4. Thesis:

◦ Short name: kratka oznaka, npr. PrezimeGodina
◦ Author(s): Prezime, I.
◦ Title: Naziv magistarskog ili doktorskog rada (bez navodnika)
◦ Publication type: Vrsta rada (doktorski rad, magistarski rad,…)
◦ University: Naziv institucije na kojoj je dodijeljen rad

12



FIZIKA  izvan okvira                                                                F□#

◦ Month: Mjesec obrane rada
◦ Year: Godina obrane rada

Konačan izgled[15]:

Author(s), „Title”, Publication type, University, Month, Year

Prezime, I.: „Naziv rada”, Vrsta rada, Naziv institucije na kojoj je 
dodijeljen rad, Mjesec obrane, Godina obrane

5. WWW document:

◦ Short name: kratka oznaka, npr. PrezimeGodina
◦ Author(s): Prezime1, I1.; Prezime2, I2.
◦ Title: Naslov internetske stranice (bez navodnika)
◦ URL: Web adresa stranice
◦ Year: Datum pristupanja web stranici

Konačan izgled[16]:

Author(s), „Title”, URL, pristupljeno: Year

Prezime1, I1.; Prezime2, I2.: „Naslov internetske stranice”, Web adresa 
stranice, pristupljeno: Datum pristupanja web stranici

Citiranje prilikom unosa u bazu treba formatirati na način da su reference u 
„eksponentskom” obliku, npr. u radu se koristi[17],[18],[19]. Popis se automatski ge-
nerira u indeksiranom dijelu Literature.
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Slika 5.2: Unos u bibliografsku bazu.

ZAHVALE

Zahvale dolaze ispred referenci. Za zahvale, dodatke i reference nema rednog 
broja.
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